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1 Introduction

This document describes how to create different types of database connections and provides a short intro-
duction to the database functionality of the StarOffice� 6.0 Software. 

Icons Used in This Guide
There are three icons used to call your attention to additional helpful information.

The Important! icon points out important information regarding data and system security.

The Note icon points out extra information: for example, alternative ways to reach a certain goal.

The Tip icon points out tips for working with the program in a more efficient manner.

Providing Feedback
We are constantly working on improving our documentation. Please send your suggestions, complaints,
criticisms, or praise to

staroffice-documentation-feedback@sun.com

A confirmation that we have received your email will be sent to you. We care about your feedback and we
will use it to further improve the StarOffice documentation. Please note that this email address is not for
requesting technical support.
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2 Adabas

Installing Adabas
Usually, StarOffice setup starts the Adabas setup directly after the StarOffice installation. However, this is
not the case with StarOffice network installations. For network installations, the Adabas setup must be
started separately.

The StarOffice CD includes an Adabas database with the following limitations:

 Five concurrent users allowed.

 Maximum database size of 100 Mbytes.

Please contact Software AG directly for an Adabas version without these limitations.

Prerequisites for Installations on Solaris� Operating Environment
Solaris� Operating Environment (OE) requires a set of kernel parameters to run an Adabas database (see
below). 

To add the kernel parameters, log in as root and add the following lines to the etc/system file:

set msgsys:msginfo_msgmni = 10
set shmsys:shminfo_shmmax = 300000000
set shmsys:shminfo_shmmni = 100
set shmsys:shminfo_shmseg = 100
set semsys:seminfo_semmni = 100
set semsys:seminfo_semmns = 100
set semsys:seminfo_semmap = 100

To activate the parameters, reboot the machine.
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Installing Adabas on Linux and Solaris

If a user will not be sharing the Adabas database, install the database under that user name rather than
root.

The setup application is called adabas and is located in the solaris/adabas or linux/adabas
directory on the StarOffice CD. 

1. Start the setup and follow the dialogs. 

2. Close all shells, log out, and then log in as the same user.

3. Double-check the values of the database environment variables. 

Open a shell and check by typing 

echo $DBVAR

where DBVAR is each of the following environment variables. Each must point to the location of the
Adabas installation:

DBROOT:  <Adabas_install_dir>

DBWORK: <Adabas_install_dir>/sql

DBCONFIG: <Adabas_install_dir>/sql

LD_LIBRARY_PATH: <Adabas_install_dir>/lib

PATH: <Adabas_install_dir>/bin:<Adabas_install_dir>/pgm

If these environment variables are not set, double-check the .profile file in the home directory of
the user. It should include the following lines for Adabas installations that are installed in the
/export/adabas directory: 

# by Sun Microsystems setup
set DBROOT=/export/adabas
set DBWORK=$DBROOT/adabas/sql
set DBCONFIG=$DBROOT/adabas/sql
set PATH=$DBROOT/bin:$DBROOT/pgm:$PATH
set LD_LIBRARY_PATH=$DBROOT/lib:$LD_LIBRARY_PATH
export DBROOT DBWORK DBCONFIG PATH LD_LIBRARY_PATH

Once the environment variables are set, the Adabas installation has been successfully finished.
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Installing Adabas on Microsoft Windows
Adabas should be installed on the same machine as StarOffice. 

1. Start the application adabas.exe located in the directory windows/adabas on the StarOffice CD
and follow the dialogs during the setup.

Do not use a blank (space) or any special characters in the directory name.
For example, the name c:\program file\adabas is not allowed; use a path like 
c:\db\adabas instead.

2. Reboot the machine.

3. Open an MS-DOS command line.

4. Use the echo command to determine the values of the environment variables, for example:

c:>echo %DBROOT
C:\Db\Adabas
c:>echo %DBWORK
C:\Db\Adabas\sql
c:>echo %DBCONFIG
C:\Db\Adabas\sql

DBROOT must be the directory where Adabas is installed; DBWORK and DBCONFIG point to the sql
subdirectory of the Adabas installation directory. 

5. If the environment variables are not set, add the following lines to your autoexec.bat file
(Windows 9x/Me) for Adabas installations located in the c:\db\Adabas directory:

set DBROOT=C:\db\Adabas
set DBWORK=%DBROOT%\sql
set DBCONFIG=%DBROOT%\sql
set path=%path%;%DBROOT%\bin;%DBROOT%\pgm

Windows NT/2000/XP users have to add these variables as system variables to the Windows system
environment.
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Creating an Adabas Database in StarOffice

Limitations
An Adabas database has some limitations that must be respected when creating a new database.

 An Adabas directory name is limited to 40 characters. 

The Adabas directory structure requires at least 10 characters, and this number must be subtracted
from the maximum length. This means you may use only 25 to 30 characters for the Adabas directory
name. Keep the length of the DBROOT directory name as short as possible.

 The length of the Adabas database name is limited to eight characters, with no blanks or other special

characters.

Do not confuse the Adabas database name with the StarOffice data source connection name. The
StarOffice data source connection name does not have this limitation.

Creating an Adabas Database Connection
1. Start StarOffice

Solaris OE and Linux users should start StarOffice from a terminal window to be able to see all prog-
ress and error messages during the creation of the database. The executable file is named soffice
and is located in the StarOffice program directory. 

2. Choose Data Sources from the Tools menu to open the Data Source Administration dialog.

This dialog provides all the tools to create a new data source connection. The left side lists all existing
database links; the right side shows the associated properties. 

The tab pages and properties change with the database type, since the different types of databases
have different properties and settings.

Illustration 1: Data Source Administration dialog in StarOffice
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3. Click the New Data Source button in the upper left corner to create a data source connection. 

Illustration 2: Data Source Administration dialog during the creation of a new
database

A new entry with the name Data source 1 appears on the left side, and the right side displays the tab
pages for a JDBC database. 

4. Select Adabas from the Database type list box.

Illustration 3: Data Source Administration dialog in the Adabas database mode

The list of tab pages on the right side now includes Adabas D and Adabas D Statistics.

5. Enter a name for the data source connection in the Name field.

6. Enter a Data source URL for an existing Adabas database. The ... button located to the right of the Data
source URL field opens a window with a list of existing Adabas databases on the machine. 

Use the following data source URL syntax to connect to an external Adabas server:
<hostname of the server>:<name of the database>
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7. If there is no existing Adabas database, click New Database in the lower right side of the dialog box to
create a new database . The Create New Adabas Database dialog box appears.

Illustration 4: Adabas database creation dialog

a. Enter a database name in the Database name field.

StarOffice uses the name of the data source connection set in the Data Source Administration
dialog. StarOffice users usually only know this data source name. The connection to the original
Adabas database name is made by the StarOffice database engine.

The Adabas database name has some limitations: Names longer than eight characters and
names with spaces or other special characters are not allowed.

b. Enter the system users in the User settings area. 

The most important user is the Administrator. Enter a name for the administrator and enter a
password by clicking Password. By default, the Control user and the Domain user use the same
password as the administrator. This can be changed by clicking Password to the right of the
corresponding field.

The Control user has the right to modify some parameters of the database. Normally, the default
settings for the name and password of the control user remain unchanged.

The Domain user is used internally by Adabas. Normally, the default settings for the name and
password remain unchanged. (You only see this field if you have called the dialog by using the
New Data Source button.)

c. Enter the system parameters for the database in the Database settings area.

SYSDEVSPACE, TRANSACTIONLOG and DATADEVSPACE define files that are required by the Adabas
database. The directory for these three files must have available space at least 2.5 times the size
of the database. These file may be located in different directories. You can find more information
about Adabas database setup on the Software AG home page at 
http://www.softwareag.com/adabasd
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SYSDEVSPACE This file includes a link table between logical data pages of the databases
and the physical location on the disk. All data in the database will be lost if
this file is damaged. The file has a size between 800 Kbytes and 2 Mbytes.

TRANSACTIONLOG This file stores the transaction log.

DATADEVSPACE This file stores the database data.

Transaction file This is the size of the transaction log file; it should be set to the same size
as the database.

Database size This is the amount of data that the database can handle. The Adabas
version in StarOffice has a size limit of 100 Mbytes. The default size is 20
Mbytes.

Data buffer size This should be set to 4 Mbytes.

8. When all settings are made in the Create New Adabas Database dialog box, click OK. 

Solaris and Linux users will see messages in the terminal that started StarOffice. Microsoft Windows
users have to wait until the dialog box disappears.

You can disregard the following error message:

No param file </export/adabas/sql/config/FIRST> 
clear not executed!

These messages indicate that the database was successfully created:

Starting server 'FIRST', please wait ...
Server 'FIRST' successfully started 

1. Adabas uses a large number of internal system tables. These tables should be hidden to the user:

a. Click the Tables tab page in the Data Source Administration dialog.

b. Clear the check boxes for the users ADMINISTRATOR and DOMAIN. 

All system databases are now hidden.

Illustration 5: Hiding the system database tables 
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2. You need to define a regular user to work with the database: 

a. Click the User Settings tab page.

b. Click Add User to create a new user.

Illustration 6: Creating a new database user with the name 'demo'

c. Enter a user name and a password in the corresponding fields.

d. Click OK to create the user.

3. Click the OK button in the Data Source Administration dialog box to store the settings.

The Adabas database is now successfully set up. 

Troubleshooting

1. The environment variables for Adabas are empty (Linux and Solaris)

 Make sure that the user logged out from the desktop after the Adabas installation.

 Double-check the .profile file for the user running the Adabas database; it must include the

set section described on page 8 of this guide. If this section exists, replace all set commands in
this section with export and remove the line beginning with export at the end of the section. It
will now look like this:

# by Sun Microsystems setup
export DBROOT=/export/adabas
export DBWORK=$DBROOT/adabas/sql
export DBCONFIG=$DBROOT/adabas/sql
export PATH=$DBROOT/bin:$DBROOT/pgm:$PATH
export LD_LIBRARY_PATH=$DBROOT/lib:$LD_LIBRARY_PATH

 Log out with the current user from the desktop.
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2. You see the error message:

Client unable to establish connection;-813 SERVERDB MUST BE
RESTARTED

This indicates that the Adabas database was not created successfully. 

 Open a terminal/DOS command line and start the following command line program:

x_start <Name of the database>

 Watch the messages. The file knldiag includes a detailed list of messages. This file is located in

the <Adabas_installation>/sql/wrk/FIRST directory. This file is an excellent source to
use when diagnosing errors.

Also check that

 the environment variables DBROOT, DBWORK, and DBCONFIG are correct.

 the variable LD_LIBRARY_PATH is set to the lib directory of the Adabas database.

 the kernel parameters are set for Solaris (see page 7 of this guide).

 the length of the Adabas directory name is no longer than 40 characters (including the Adabas

subdirectories).

 the length of the Adabas database name is shorter than 9 characters.

 there is sufficient disk space (a default database requires at least 50 Mbytes).

3. The Adabas tools to create databases do not work

The Adabas tools create databases with a default user number of 50. This is not allowed by the
StarOffice version of Adabas. Use the central configuration tool XCONTROL to change the kernel
parameter MAXUSERTASKS to 3.

The XCONTROL tool is very powerful and is used to set up, maintain, and monitor Adabas databases.
You find more information about XCONTROL on the Adabas homepage on 
http://www.softwareag.com/adabasd
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3 JDBC� Technology

StarOffice can communicate with a database using a JDBC� API driver class provided by the database
manufacturer. You find two examnples for JDBC driver classes below.

Oracle Database Driver Class
We recommend using the JDBC database connection interface for Oracle databases with Solaris OE and
Linux while using the ODBC database connection interface with Microsoft Windows.

The Oracle database client must be installed with JDBC support. The JDBC driver class from the Solaris OE
Oracle client version 8.x is located in the
<Oracle client>/product/jdbc/lib/classes111.zip directory. You can also download the
latest version from the Oracle homepage:

http://otn.oracle.com/tech/java/sqlj_jdbc/content.html

MySQL Databases Driver Class
Use the mm.mysql-2.0.4-bin.jar driver archive available from 
http://www.mysql.org/downloads/api-jdbc.html

The driver archive must be part of the CLASSPATH for the JAVA� Runtime Environment on the machine, or
must be added to the StarOffice CLASSPATH. 
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To add the archive to the StarOffice Java CLASSPATH within StarOffice:

1. Choose Options - StarOffice - Security from the Tools menu.

Illustration 7: Option dialog to add an additional driver archive to StarOffice

2. Click the ... button to the right of the ClassPath field to open the Select Archives dialog box to browse
for the driver archive.

 

Illustration 8: Browse to the JDBC driver file

3. Click Add and browse to the location of the JDBC driver archive file to add it to the StarOffice CLASS-
PATH. 

4. Click OK to store the settings.
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Creating a JDBC Database Connection
1. Choose Data Sources from the Tools menu to open the Data Source Administration dialog. 

Illustration 9: Data Source Administration dialog in StarOffice

This dialog provides all the tools to create a new data source connection. The left  side lists all existing
data sources; the right side shows the associated properties.

The tab pages and properties change with the database type, since the different types of databases
have different properties and settings.

2. Click New Data Source in the upper left corner to create a data source connection. A new entry with
the name Data source 1 appears on the left side, and the right side displays the tab pages for a JDBC
database. 

Illustration 10: Data Source Administration dialog during the creation of a new database

3. Enter the database URL in the field Data source URL. The syntax of this database URL changes with the
database type. See your driver's documentation for more information. 

The syntax for a MySQL database looks like this:

mysql://hostname:port/database name

with

hostname The name or IP address of the machine that runs the database.

port The port for connecting to the MySQL database (default: 3306).

database name The name of the database to connect to. MySQL  can run many databases in
parallel; this parameter specifies one.

Example: mysql://turner:3306/ADDRESS
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The syntax for an Oracle database looks like this:

oracle:thin:@hostname:port:database name

with

hostname The name or IP address of the machine that runs the Oracle database.

port The port for connecting to the Oracle. Ask your database administrator for the
correct port number.

database name The name of the Oracle database. Ask your database administrator for the
name.

Example: oracle:thin:@turner:1521:ADDRESS

4. Enter a name for the database connection in the Name field. This name will be used by StarOffice for
all types of database activities. 

5. Click on the JDBC tab page to complete the creation of the data source connection. 

Illustration 11: JDBC tab page of the Data Source Administration dialog

6. Insert the class name of the JDBC driver in the JDBC driver class field. You will find the name in the
JDBC driver documentation.

The class name of the MySQL driver is: org.gjt.mm.mysql.Driver

The class name of the Oracle 8.x driver is: oracle.jdbc.driver.OracleDriver

7. The URL field contains the database URL described above. 

8. Enter a database user name in the User name field. StarOffice will use this name to communicate with
the database. 

9. Check the Password required box if the user requires a password for connecting to the database.
StarOffice will ask the user to enter the password during runtime.

10. Click on the Tables tab page to verify the database connection. 

If you see the list of database tables you have successfully created the JDBC database connection. 
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Troubleshooting

1. You see the error message:

No connection could be established for the URL: jdbc......

Check the following:

 Is the database server running? 

 Is the host name correctly spelled and reachable? Check with a ping command, try using the IP

address instead of the host name.

 Is the port number correct? 

 Are the user name and password spelled correctly? 

 Does the database name exist on the database server?

2. You see the error message:

The connection to the database source "..." could not be established
The specified driver could not be loaded

This means the JDBC driver could not be loaded by StarOffice. Check the following: 

 Is the JDBC driver archive part of the system or StarOffice Java CLASSPATH? See the instructions on

page 18 for information on adding the JDBC driver archive.

 Is  the name of the JDBC driver class spelled correctly (see Illustration 11)?  The JDBC driver

documentation shows the correct name. 

3. You see the error message:

Error reading data from the database. Oracle-DLL could not be
loaded! Please check your installation.

Download and install the latest JDBC driver version from Oracle. You will find the download and all
required information on:

http://otn.oracle.com/tech/java/sqlj_jdbc/content.html

4. You see the error message:

Dismiss write access to Oracle databases tables

StarOffice 6.0 is unable to write data in the Oracle database. This is a known problem, and will be fixed
as soon as possible. 
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4 ODBC

All Microsoft Windows installations normally include an ODBC driver. You will find the latest revision in
the Microsoft Data Access Components (MDAC) package from Microsoft. This package is located at:

http://www.microsoft.com/data/mdac21info/manifest_intro.htm

We recommend using the JDBC database connection interface for Solaris and Linux while using the
ODBC database connection interface with Microsoft Windows. You can find  an ODBC implementation
for Solaris and Linux on  http://www.unixodbc.org.

Microsoft Access databases should be connected via the ADO database interface, rather than via ODBC.

Preparing Oracle 8i Databases
The ODBC interface for Oracle databases requires the installation of the Oracle Database Client software.
This client is part of the Oracle database installation set. After the installation of the Oracle client you
need to create a new service name. 

The service name stores all information needed to connect to the database server. Oracle provides  Net8
Assistant, an application for setting up the database client. After you have set up the database client,
write down the service name; you will need it later for the ODBC driver setup.

It is very important to set up the Oracle client correctly. The data source connection setup is based on
this client. Ask your Oracle database administrator for a detailed description that applies to your instal-
lation.
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Creating an ODBC Database Connection
This procedure was tested under Microsoft Windows.

1. Choose Data Sources from the Tools menu in StarOffice to open the Data Source Administration dialog.

Illustration 12: Data Source Administration dialog in StarOffice

This dialog provides all the tools to create a new data source connection. The left  side lists all existing
data sources; the right side shows the associated properties.

The tab pages and properties change with the database type, since the different types of databases
have different properties and settings. 

2. Click New Data Source in the upper left corner to create a data source connection. A new entry with
the name Data source 1 appears on the left side, and the right side displays the tab pages for a JDBC
database. 

Illustration 13: Data Source Administration dialog during the creation of a new
database

3. select ODBC from the Database type list. The tab pages for an ODBC database now appear on the right.

Illustration 14: Data Source Administration dialog to create a new ODBC data
source connection

24     StarOffice 6.0  Setting Up Database Connections



4. Enter a name for the data source connection in the Name field.

5. Click ... next to the Data source URL field and select an existing ODBC database connection and
proceed to step 15.

Illustration 15: All available ODBC data source items

6. To create a new ODBC database connection, click Organize to open the ODBC Data Source Adminis-
trator dialog. 

Illustration 16: ODBC Data Source Administrator dialog in Windows
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7. Click Add to open the Create New Data Source dialog

Illustration 17: Creating a new Oracle ODBC data source connection

8. Select Oracle ODBC Driver from the list and click Finish. This opens the Oracle8 ODBC Driver Setup
dialog.

Illustration 18: Oracle 8 ODBC driver setup

9. Enter a name for the new Oracle data source connection in the Data Source Name field. 

10. Enter the name you obtained from Oracle Net8 Assistant for the service name in the Service Name
field. 

11. Contact your Oracle database administrator for a user id and enter it in the UserID field. 
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12. Click OK to close the dialog. 

The ODBC Administrator Data Source window now displays the new data source connection.  

13. Click OK to apply the changes. 

The dialog will close and the StarOffice Data Source dialog will now contain the name of the new data
source connection. 

Illustration 19: Data source chooser with the new ODBC data source

14. Select the name of the data source connection and click OK.

15. Click the ODBC tab page in the StarOffice Data Source Administration dialog 

Illustration 20: The ODBC tab page of the data source administration

16. Insert the user name for the Oracle database in the User name field.

Use the same user name as you used in the ODBC Driver Setup dialog. StarOffice uses this user name
to communicate with the database. 

17. Click the Tables tab to check the connection to the database to hide the system database tables. These
system database tables are used internally by Oracle; there is no need to display the tables to the
users.
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18. Clear all check boxes for the system tables.

The system tables for Oracle are CTXSYS, MDSYS, ORDSYS, OUTLN, and SCOTT. 

Illustration 21: List of database tables of the current ODBC database

19. Click OK to save the database connection.

Troubleshooting
1. You see the error message:

The connection to the data source "..." could not be established.
[Oracle][ODBC][Ora]ORA-12154:TNS:Could not resolve the service name.

This error message does not come from StarOffice. This means the Oracle database client is unable to
communicate with the database.

 Open the Oracle ODBC Driver Setup dialog (see illustration 18) and check the value of the Service

Name field. This must be the same name that was used in Net8 Assistant. If you did not use Net8

Assistant, check the value of Service Name in the file TNSNAMES.ORA. 
 Net8 Assistant provides a test functionality. Use it to see if you can connect to the database.

 Verify that the file TNSNAMES.ORA exists, is in the correct location, and is accessible.  See the

operating-system-specific manual for details on the required name and location.

Make sure there are no syntax errors anywhere in the file. Check carefully for mismatched
parentheses or stray characters.

2. You see the error message:

The connection to the data source "..." could not be established.
Please check the current settings, e.g. user name and password.

The user name is unknown by the Oracle database server.

 Check the value of the User name field on the ODBC tab page of the StarOffice Data Source

Administration dialog (see illustration 20). 

 An Oracle user normally requires a password. Verify that the Password required box is checked (see

illustration 20).

 Ask your Oracle database administrator for the correct user name and password.
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5 ADO

ADO is a Microsoft Windows proprietary interface container for connecting to databases. The container
implements an interface to data providers. A data provider is similar to a driver and allows ADO to interact
with a database. 

There is a long list of database providers. For a good summary, see: 
http://www.able-consulting.com/ADO_Conn.htm or the Microsoft homepage. The following
examples use ADO with a Microsoft Access database.

The ADO connection type is only available under Microsoft Windows.

StarOffice requires Microsoft Data Access Components (MDAC) in order to make use of the ADO interface.
MDAC is freely available, and can be downloaded directly from Microsoft. Microsoft Windows XP and 2000
already include MDAC.

More details can be found at:
http://www.microsoft.com/data/mdac21info/manifest_intro.htm

Creating an ADO Database Connection
1. Choose Data Sources from the Tools menu in StarOffice to open the Data Source Administration dialog.

Illustration 22: Data Source Administration dialog in StarOffice

This dialog provides all the tools to create a new data source connection. The left side lists all existing
data sources; the right side shows the associated properties. 

The tab pages and properties change with the database type, since the different types of databases
have different properties and settings.
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2. Click New Data Source in the upper left corner to create a data source connection.

A new entry named Data source 1 appears on the left side, and the right side displays the tab pages for
a JDBC database.

Illustration 23: Data Source Administration dialog during the creation of a new
database

3. Select ADO from the Database type list. The tab pages for an ADO database now appear on the right.

4. Enter a name for the data source connection in the Name field. This is the connection name that
StarOffice will use. 

Illustration 24: Creation of an ADO connection with the Data Source
Administration dialog 

5. Enter an ADO data connection string for the data source in the Data source URL field.

Connection String for Microsoft Access

PROVIDER=Microsoft.Jet.OLEDB.4.0;DATA SOURCE=MDB-File

with

MDB-File Path and filename of the .mdb file that represents the Microsoft Access database.

Example: 
PROVIDER=Microsoft.Jet.OLEDB.4.0;DATA SOURCE=c:\address.mdb
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Connection String for Microsoft SQL Server

PROVIDER=sqloledb;DATA SOURCE=Servername;INITIAL CATALOG=Catalog name

with

Servername Host name of the machine running the Microsoft SQL server.

Catalog name Name of the initial catalog of the databas, the name of the database that
runs on the server.

Example:
PROVIDER=sqloledb;DATA SOURCE=turner;INITIAL CATALOG=First

6. Click the ADO tab in the Data Source Administration dialog.

7. Enter the the user name for the database connection in the User name field.

Usually a Microsoft Access database does not have a user defined; if this is the case, do not insert a
name into the User name field. 

A Microsoft SQL Server requires a user name and password. Check the Password required box and the
user will be asked for a password when opening the database connection.

Illustration 25: Data Source Administration dialog tab page to insert a user name

8. Click the Tables tab to subscribe or unsubscribe the database tables within the database. 

StarOffice also displays the tables that are used internally by Microsoft Access. These tables start with
Msys for Access and sys for SQL Server. Hide these tables by clearing the boxes next to the table
names.

Illustration 26: Tables tab page to hide system tables for a Microsoft Access
database
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Troubleshooting

1. You see the error message:

No connection could be established for the URL: sdbc:ado...... for
Microsoft Access databases. 

 Make sure there are no typos in the database file name or connection string. 

 Check if the Access database has a user or a password. 

 Install the newest version of  Microsoft Data Access Components (the location is given above). We

recommend MDAC version 5.6.

2. You see the error message:

No connection could be established for the URL: sdbc:ado...... for
Microsoft SQL-Server databases.

 Make sure there are no typos in the connection string. 

 Do a ping command to the host name and see if it answers. 

 Make sure the SQLServer is running. 

 Install the newest version of  Microsoft Data Access Components (the location is given above). We

recommend MDAC version 5.6. 
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6 dBase

dBase databases are not database servers like Adabas or a single files like Microsoft Access. They are
based on the content of a directory. All files with the extension dbf that are located in a special directory
are part of the database source. 

It is very easy to create and maintain a dBase database. This is its biggest advantage.  But the perform-
ance is slow, so we don't recommend it for databases with more than 1,000 data rows.

Creating a dBase Database Connection
1. Choose Data Sources from the Tools menu in StarOffice to open the Data Source Administration dialog.

Illustration 27: Data Source Administration dialog in StarOffice

This dialog provides all the tools to create a new data source connection. The left side lists all existing
data sources; the right side shows the associated properties.

The tab pages and properties change with the database type, since the different types of databases
have different properties and settings. 
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2. Click New Data Source in the upper left corner to create a data source connection. 

A new entry named Data source 1 appears on the left side, and the right side displays the tab pages for
a JDBC database. 

Illustration 28: Data Source Administration dialog during the creation of a new
database

3. Select dBase from the Database type list. The tab pages for a dBase database now appear on the right.

Illustration 29: Data Source Administration dialog to create a new dBase database
connection

4. Click ... on the right side of the Data source URL field and select the base directory for the dBase data-
base. This directory must contain all dbf files. 

5. Enter a name for the data source connection in the Name field.

6. Click the Tables tab to check the available database tables. 

A check box next to a table name controls whether the database table will be displayed or not. To hide
the database table clear the corresponding check box.

Illustration 30: List of all dBase files located in a directory
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Troubleshooting

1. You see the error message:

Error while connecting to the data source 
[StarOffice Base dbase] The file 'file:/...' is an invalid or
unrecognized dbase file

All files with the extension dbf will be displayed as database tables. This error message indicates that
a file is not a valid dBase file. StarOffice supports files from dBase version 3 and higher.
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7 Text

The Text database connection type allows you to import structured text files in the database front end.
You can create queries to filter the data.

This type of database connection can only read plain text files, not StarOffice Writer or Microsoft Word
documents. These files need to be structured using a separator between data fields, for example:

"one";"two";1.0;1,000;10000

Data source connections to text files are directory-oriented. This means that one data source connection
represents all files in a directory. These files will be displayed as database tables. This make it possible to
import a large set of text files.

Text files will be imported read only. It is not possible to edit such files with the database front end of
StarOffice. Use a database like Adabas or dBase for this purpose instead.

Creating a Data Source Connection With Text Files
1. Choose Data Sources from the Tools menu in StarOffice to open the Data Source Administration dialog.

Illustration 31: Data Source Administration dialog in StarOffice

This dialog provides all the tools to create a new data source connection. The left side lists all existing
data sources; the right side shows the associated properties.

The tab pages and properties change with the database type, since the different types of databases
have different properties and settings.
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2. Click New Data Source in the upper left corner to create a data source connection.

A new entry with the name Data source 1 appears on the left side, and the right side displays the tab
pages for a JDBC database.

Illustration 32: Data Source Administration dialog during the creation of a new
database

3. Select Text from the Database type list. The tab pages for a Text database now appear on the right.

Illustration 33: Data Source Administration dialog to create a Text database
connection

4. Click ... next to the Data source URL field and select the base directory for the text files. All files in this
directory are displayed as database tables.

5. Enter a name for the data source connection in the Name field. 

Illustration 34: Dialog for specifying the row format of Text files
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6. Click the Text tab to specify the row format of the text files in detail. Ensure that these properties are
correct to prevent errors during the data import.

To prevent display errors for special characters, select the correct character set, especially if the file
came from a different operating system.

7. Click the Tables tab to check the list of database tables. 

A check box next to a table name controls whether the database table will be displayed or not. To hide
the database table clear the corresponding check box.

Illustration 35: List of text files located in a directory

Troubleshooting

1. Special characters are not correctly displayed

This indicates that the data source connection is using the wrong character set. Use the Text tab page
in the Data Source Administration dialog to select a different character set.  

2. Date values from the text files are displayed as floating numbers

This means the data source Text import filter cannot display date formats correctly. Use a database
like Adabas or dBase to store such complex values.
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8 Spreadsheet

With the Spreadsheet data source connection, you can use a spreadsheet document as a data source for a
database. 

All sheets in the spreadsheet document that include data will be imported as database tables. This means
that a spreadsheet document that contains data on two sheets will be imported as two database tables.

The contents of the spreadsheet documents cannot be edited within the data source connection. Use a
database like Adabas or dBase for this purpose instead.

Creating a Spreadsheet Data Source Connection
1. Choose Data Sources from the Tools menu in StarOffice to open the Data Source Administration dialog.

Illustration 36: Data Source Administration dialog during the creation of a new
database

This dialog provides all the tools to create a new data source connection. The left side lists all existing
data sources; the right side shows the associated properties.

The tab pages and properties change with the database type, since the different types of databases
have different properties and settings.

2. Click New Data Source in the upper left corner to create a data source connection. 

A new entry with the name Data source 1 appears on the left side, and the right side displays the tab
pages for a JDBC database. 
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3. Select Spreadsheet from the Database type list. The tab pages for a Spreadsheet database now appear
on the right.

Illustration 37: Data Source Administration dialog to create a Spreadsheet data
source connection

4. Click ... next to the Data source URL field and select a spreadsheet document that contains the data for
the data source connection.

5. Enter a name for the data source connection in the Name field.

6. Click the Tables tab to check the data connection.

Illustration 38: A spreadsheet with two sheets with data
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9 Address Book

This type of data source connection is different from the other data source connection types described so
far. The Address Book connection does not connect directly to a database or database file but uses an
address book handler to connect to an address book.

The following types of address books can be read: 

 LDAP

 Mozilla (Netscape)

 Microsoft Outlook

 Microsoft Windows Address Book 

The Outlook and Windows address books are only available under Microsoft Windows.

The data values of an address book cannot be edited.

StarOffice provides an AutoPilot to create an Address Book data source connection.  Start this AutoPilot
by choose File - AutoPilot - Address Data Source in StarOffice.

Creating an Address Book Data Source Connection
1. Choose Data Sources from the Tools menu in StarOffice to open the Data Source Administration dialog.

Illustration 39: Data Source Administration dialog in StarOffice

This dialog provides all the tools to create a new data-source connection. The left side lists all existing
data sources; the right side shows the associated properties.

The tab pages and properties change with the database type, since the different types of databases
have different properties and settings.
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2. Click New Data Source in the upper left corner to create a data source connection. 

A new entry with the name Data source 1 appears on the left side, and the right side displays the tab
pages for a JDBC database. 

Illustration 40: Data Source Administration dialog during the creation of a new
database

3. Select Address Book from the Database type list. The tab pages for an Address Book database now
appear on the right.

4. Click ... next to the Data source URL field to open the Data Source dialog for choosing the address book
type.

Illustration 41: Data Source Administration dialog to create a new Addressbook
data connection

5. In the Data Source dialog select one of the data sources and click OK.

Illustration 42 Dialog for choosing the address book type 
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LDAP address book Use this data source if you want to connect to an LDAP server.
Ask your system administrator for more information about your
LDAP server.

Mozilla address book Use this connection type if you want to connect to the address
book of your Netscape or Mozilla browser.

MS Outlook Use this connection if you want to connect to the address book
in Microsoft Outlook. However, the group address book in the
Exchange server cannot be accessed.

Windows address book Use this connection if you want to connect to the  Microsoft
Windows address book.

6. Click the Tables tab in the Data Source Administration dialog to connect to the address book.

Illustration 43: The Tables tab page for a Netscape address book

The list of tables

varies with the address book type. Illustration 43 shows tables for a Netscape/Mozilla address book.

7. Click OK to store the settings.
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10 Working With Existing Databases

This section describes the usage of existing data sources. The procedure is common to all types of data
source connections. 

We will use the data source connection named Bibliography as example in theis section since it is
included in all StarOffice installations.

 Press F4 or choose Data Sources from the View menu in StarOffice.

The left side of the window shows a list of all available data sources. Clicking the plus sign (+) in front
of each listed data source displays all available items.

Illustration 44: Data Sources dialog

In Illustration 44, the Bibliography data source is opened, and Links, Queries and Tables are listed.

 Click the plus sign to display all available entries of these items.

Illustration 45: Display of all available items in the �Bibliography� database

In Illustration 45, the Bibliography database has one database table biblio and no queries or links. 
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 Click on biblio and the right side of the window shows the data rows in the biblio table. 

Illustration 46: View of the database content of the �biblio� table

You can now edit the database content. 

 The data row navigation bar at the bottom of the dialog allows you to navigate through the database.

Displays the current selected row number. You can enter a row number here to
directly go to that row. 

Moves to the first, previous, next, or last data row, respectively. 

Creates a new data row.

 The toolbar at the top of the dialog allows you to filter and sort the data rows.

Opens a dialog to define search parameters for the data table content.

Sorts the data table content in ascending or descending order. The selected data
column is used as the sort condition.

Builds a filter condition from the currently selected item (Autofilter). 

Opens an additional dialog to build a filter condition (Default Filter).

Opens a dialog to set up a complex sort order.

Removes all filter and sort conditions that are currently active.

Indicates if a filter condition is active; the button is pressed if a condition is active.

Refreshes or rebuilds the display of all currently listed data rows.
A refresh does not re-read the data from the database table. This is a fast method to
make sure that all data rows will print correctly and that the data filter works correctly. 
A rebuild reads the data directly from the database; this method is slower but it reads
the latest data rows from the table.

Switches between the read only and edit mode for the data rows. A pressed button
indicates the edit mode.

Saves the edited data values.

Undoes the data changes.

Cuts, copies and pastes the selected data value to or from the clipboard.
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11 Form Letters

Creating a Form Letter Document
Form letters can be associated with data using the Data Sources dialog.

1. Create a text document by choosing New from the File menu. 

2. Press F4 to open the Data Sources dialog.

3. Open the data source connection you want to use for the form letter as described in Chapter 10:
Working With Existing Databases. 

In the following examples we will use the Bibliography data source connection for creating a form
letter.

Illustration 47: Data sources dialog displaying the data in �biblio�

A form letter document includes fields that are associated with a data source column. The value of
these fields changes during the printing of the form letter. There are two ways to add such fields to a
document:

 You can use the menu to choose Insert - Fields - Other - Database - Form letter field.

 You can drag and drop the column headers from the Data Sources dialog to the document (see ). 
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Illustration 48: Inserting a form letter field in a text document using drag and
drop

4. Add all database fields you want to use in your form letter to the text document. 

The initial caption of the form letter field displays the database field name. This will be replaced by the
data content during the printing of the form letter document.

5. After all fields are placed in the document select one data row in the Data Sources dialog, and click
the Data to Fields icon in the toolbar to check how the document will look with the content from the
database. 

Data to Fields: Inserts the values of the currently selected data row into the form letter fields.

All form letter fields in the document are now filled with the data from the selected data row.

Printing a Form Letter Document
1. Click the Form Letter icon to open the Form Letter dialog.

Form Letter: Opens a dialog to start printing a form letter.

Illustration 49: Dialog to start  form letter printing

2. Select a data range to include in form letter printout in the Records area.

3. Select an output medium in the Output area.

 Printer means a normal printer. 

 Electronic sends the form letters as email.

 File creates a separate file for each form letter. 

Check the Single print jobs box to create a separate print job for each form letter. This is useful, for
example, when sending form letters by fax.
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12 Creating a Database Table

This section describes the creation of a database table within a data source connection.

1. Press F4 to open the Data Sources dialog.

2. Open the data source connection in which you want to create a new table as described in Chapter 10:
Working With Existing Databases. 

Illustration 50: Data source dialog displaying the �Bibliography� data source
connection

3. Select Tables (see Illustration 50) and click the right mouse button to open the context menu. 

4. Click New Table Design to open the Table Design dialog.

Illustration 51: Table Design dialog to create new database tables

5. Enter a name for the first field of the new database table in the first (see Illustration 51).
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6. Select a field type from the list box that appears in the second column (see ).

Illustration 52: Inserting the first field of the new database table

The list of the available field types varies with the database type.

7. Insert a description for the field in the third column. This text is optional and only for informational
purposes. Each field type has a set of properties, like Length or Default value. These properties are
listed in the lower part of the window. 

8. When all fields are defined click the Save icon to save the new table design under a new name.

Save: Saves the table design.

Inserting Data Into the Database Table
1. Open the database you want to add data to as described in Chapter 10: Working With Existing Data-

bases. 

Illustration 53: The empty database table �address�

2. Click in the first column and enter the contents for the first field. 

3. Press Tab to go to the next column and insert the contents for the second field.

4. When you press Tab while in the last column of a row the cursor moves to the beginning of a new line
where you can enter another row of data.
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13 Creating a Query

The Data Sources dialog provides filters for finding data in the database. However, when you use a filter
its criteria are not saved. A query finds data and also allows you to save the search criteria.

1. Open the data source connection in which you want to create a new table as described in Chapter 10:
Working With Existing Databases. 

2. Select Queries and click the right mouse button to open the context menu (see ).

Illustration 54: Context menu to create a new database query

3. Do one of the following:

 Choose New Query Design to open a dialog to create a query (see Creating a Query With the Query

Design Dialog below).

 Choose New SQL Command to create a query using SQL commands. SQL is a database query

language and is beyond the scope of this guide. This is recommended only for experienced users.
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Creating a Query With the Query Design Dialog
1. Choose New Query Design from the context menu to open the Add Tables dialog.

Illustration 55: Query design dialog to create queries

The Add Tables dialog displays all available tables of the current database.

2. Select  the table you want to create a query for and click Add.

Illustration 56: Database table within the query design view

The selected table is displayed in the Query Design dialog. We have now defined the table to be part of
the query. This example just includes one single table; usually larger databases will include more than
one table per query.
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3. Specify the table fields to be included in the query. 

You can either drag and drop the fields into the area below the database table (see ), or double-click
on the field name.

Illustration 57: Adding the fields to be displayed within the query

The database field appears in the Field row. Only this field will be displayed in the query. 

The database table view includes * as the first field name in the list. If you drag this * into the field
area below, all fields in the table will be displayed within the query.

4. Click the Run Query icon to execute the query.

Run Query: Executes the current query and displays the result.

The Query Design dialog will be extended, and a list of data rows that fit the query conditions appears.

5. Define the search criteria for the query. 

The area below the database table provides the functionality to define search criteria (see ).

Illustration 58: Criteria design area
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Field Name of the database table field. �*� represents all fields of the database table.

Alias Alias to be displayed instead of the database table name. This can be useful in
creating more readable query output. 

Table Name of the table that includes the selected field.

Sort Sort the values of the field in ascending or descending order.

Visible Show the field in the database output. This is helpful for fields that are used to
define criteria, but do not need to be displayed in the query output.

Function Pre-defined set of functions to count the number of rows, etc. The list of available
functions depends on the data source type.

Criterion Defines a criterion for the query.

Or All criteria that are located in the same column have an OR relationship. All
criteria that are located in different columns have an AND relationship. The syntax
of the criteria is described in the StarOffice help system.

6. Insert a search criterion in the  Criterion row.

7. Click the Run Query icon in the toolbar.

The resulting data rows are displayed in the top section (see )

Illustration 59: Result of the query
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14 Creating a Database Form

StarOffice includes flexible database form capabilities. A database form is a StarOffice document including
a set of database controls. The New Form AutoPilot provides the fastest way to create a database form.

1. Open the data source connection in which you want to create a new table as described in Chapter 10:
Working With Existing Databases.

2. Select Links and click the right mouse button to open the context menu.

Database forms are stored as StarOffice documents. The data source connection stores a link to a form
document; this is why the item is called Link and not  Form here.

3. Select New Form to open and then AutoPilot.

Illustration 60: The context menus to open the form AutoPilot in the �Bibliography� database

4. Choose the database table to be used as a data source from the Tables or queries list.

Illustration 61: Using the AutoPilot to choose fields for a database form

5. Choose the fields to be part of the new form. 
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Press -> to add the field selected in the Existing fields list, or press =>> to add all fields from the
Existing fields list. You can use <- and <<= do remove selected fields from the Fields in form list.

6. Press Next once all required fields are added.

Illustration 62: Style definition in the database form

7. Select the layout of the form using the options in the dialog and press Create to create the form.

8. Enter a name for the form document. We recommend to keep the form documents in the same direc-
tory as the database tables.

9. StarOffice now displays the new database form.
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15 Working With Database Forms

1. Open the data source connection in which you want to create a new table as described in Chapter 10:
Working With Existing Databases.

2. Select Links to list all forms for the database.
If no form is listed you can create a new database form using the New Forms AutoPilot described in
Chapter 14: Creating a Database Form.

3. Doubleclick a form name to open it.
A window with the form appears. You can use the navigation bar in the lower part of the window to
create, edit, remove, and filter data rows:

Displays the active row number. You can enter a row number to move to that row.

Moves to the first, previous, next, or last data row, respectively.

Saves the edited data values.

Undoes the data changes.

Creates a new data row.

Removes the current data row.

Refreshes the current data row.

Opens a dialog to define search parameters for the data table content. 

Sorts the data table content in ascending and descending order. The selected data
column is used as the sort condition.

Builds a filter condition from the currently selected item (AutoFilter).

Activates the form-based filter function. You can insert search criteria in the database
form.

Opens a dialog to set up a complex sort order.

Removes all filter and sort conditions that are currently active.

Opens an additional window with a list of all available data rows.

Indicates if a filter condition is active; the button is pressed if a condition is active.
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16 Editing a Database Form

The New Form Autopilot (see chapter 14) helps you to create a new database form. This section provides a
short introduction on how to edit an existing form.

1. Open the data source connection in which you want to create a new table as described in Chapter 10:
Working With Existing Databases.

2. Select Links to see the list of database forms associated with the database.

3. Select one of the forms and click the right mouse button and select Edit Document from the context
menu. 

Illustration 63: Context menu to open a database form in the edit mode

A new window with the database form is shown.

To change a database form, you need to open the form in the edit mode. You can also switch to the
edit mode in an opened database form by clicking on the 

4. If you have already opened the database form read-only, click the Edit File icon to switch to edit mode.

Edit File: Switches between edit mode and read-only mode.

5. Once the database form document is in edit mode, click the Show Form Functions icon on the vertical
toolbar to open a flyer with tools for the database form design.

Show Form Functions: Opens the database form functions toolbar.
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Illustration 64: Form functions dialog with tools for editing forms

Selects a control in the database form.

Lists all properties of the currently selected control.

Lists all properties of the database form.

Opens a window for changing the activation order when using Tab for navigating through the
form.

Provides an overview of the structure of the database form including a list of controls, forms,
and sub-forms for the document.

Activates and deactivates design mode.

A list of all possible controls for a database form.
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Providing Feedback
We are constantly working on improving our documentation. Please send your suggestions, complaints,
criticisms, or praise to

staroffice-documentation-feedback@sun.com

A confirmation that we have received your email will be sent to you. We care about your feedback and we
will use it to further improve the StarOffice documentation. Please note that this email address is not for
requesting technical support.
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